
Chapter 1

Braving the Elements
In This Chapter
� Introducing Photoshop Elements

� Working with the painting tools

� Understanding the image-editing tools

� Using Elements’ helpful Help features

As you know if you read the Introduction to this book, the image-editing
powers of Photoshop Elements are inherited from another Adobe applica-

tion called simply “Photoshop.” But you still may not be aware that Photoshop
is the most comprehensive and popular image editor around. In fact, there’s
probably not a single computer artist who doesn’t use Photoshop almost daily.
As an Elements user, you have most of that professional power coiled up inside
your computer, waiting for you to discover how to harness it.

Even if you haven’t yet used Elements or Photoshop, you probably have at
least a vague idea of what they’re all about. But just so we’re all clear on the
subject, the primary purpose of these applications is to make changes to pho-
tographic images that you’ve managed to get on disk, whether from a digital
camera, a scanner, or other means. Windows users also have the Organizer
component of Elements, which lets you organize and arrange your digital
image collection. We examine the Organizer half of Elements in Windows in
Chapter 6; for now, when we refer to “Elements,” we’re referring to the Editor
component of the Windows version, which is basically equivalent to the entire
Mac version.

If you’ve used Elements for only a week or so, you may have mistaken it for a
fairly straightforward package. Certainly, on the surface, Elements comes off as
quite friendly. But lurking a few fathoms deep is another, darker program, one
that is distinctly unfriendly for the uninitiated but wildly capable for the stout
of heart. Sigmund Freud would no doubt declare Elements a classic case of a
split personality. It’s half man, half monster; half mild-mannered shoeshine boy,
half blonde-grabbing, airplane-swatting King Kong. In short, Elements has a 
Dr. Jekyll-and-Mr. Hyde thing going — only it’s way scarier.
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As you may recall from the last time you saw Abbott and Costello Meet Dr. Jekyll
and Mr. Hyde — indisputably the foremost resource of information on this
famous tale — this Jekyll character (not to be confused with the similarly
named cartoon magpie) is normally your everyday, average, nice-guy scientist.
Then one day, he drinks some potion or gets cut off in traffic or something and
changes into his ornery alter ego, known at every dive bar in town by the sur-
name Hyde. Elements behaves the same way, except no magical transformation
is required to shift from the easy-to-use part of the program to the scary, tech-
nical side. Both personalities — both “elements,” if you will — coexist simulta-
neously in symbiotic harmony.

This chapter explores both the cuddly and not-so-cuddly parts of Elements’
brain. (We’ll leave the exploration of Abbott’s and Costello’s brains for another
book.) We’ll also take a look at the built-in Help features, which are the chief
means of distinguishing Elements from its not-so-friendly big brother,
Photoshop.

The Bland but Benevolent Dr. Jekyll
To discover the benevolent Dr. Jekyll side of Photoshop Elements, you need
look no further than the standard painting and editing tools. Shown in Figure
1-1, these tools are so simple they’re practically pastoral, like the kind of
household appliances your great-grandmother would have been comfortable
with. The eraser tool erases, the pencil tool draws hard-edged lines, the
brush tool paints, and so on. These incredibly straightforward tools attract
new users just as surely as a light attracts miller moths.

Figure 1-1:
Many tools
in Elements

have an 
old-world,

rustic
charm that’s

sure to
warm the

cockles 
of the 

most timid
techno-
phobe.
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But you quickly discover that these tools, just like the boring Dr. Jekyll, aren’t
super-duper exciting on their own. They don’t work much like their tradi-
tional counterparts — a line drawn with the pencil tool, for example, doesn’t
look much like a line drawn with a real pencil — and they don’t seem to be
particularly applicable to the job of editing images. Generally speaking, you
have to be blessed with pretty strong hand-eye coordination to achieve good
results using these tools.

The Dynamic but Dastardly Mr. Hyde
When the standard paint and editing tools don’t fit the bill, you might try to
adjust the performance of the tools and experiment with the other image 
controls of Elements. Unfortunately, that’s when you discover the Mr. Hyde
side of the program. You encounter options that have meaningless names
such as Dissolve, Multiply, and Difference. Commands such as Image Size and
Brightness/Contrast — both of which sound harmless enough — can easily
damage your image. It’s enough to drive a reticent computer artist stark
raving insane.

The net result is that many folks return broken and frustrated to the under-
equipped and boring but nonthreatening painting and editing tools that
they’ve come to know. It’s sad, really. Especially when you consider all the
wonderful things that the more complex Photoshop Elements controls can
do. Oh sure, the controls have weird names, and they may not respond as
you think they should at first. But after you come to terms with these slick
puppies, they perform in ways you wouldn’t believe.

In fact, the dreaded Mr. Hyde side of Elements represents the core of this
powerful program. Without its sinister side, Elements is just another rinky-
dink piece of painting software whose most remarkable capability is keeping
the kids out of mischief on a rainy day.

It must be noted, however, that even the dastardly Mr. Hyde side of Elements
can have a friendly face, namely in Elements’ new Quick Fix mode. This mode
lets you deal with the complex task of image editing using greatly simplified
controls. Compared to a snarling, maniacal real-world encounter with the
powerful Mr. Hyde, this is sort of the Hanna-Barbera cartoon version. We visit
the Quick Fix mode in Chapter 12.

The Two Elements of Photoshop Elements
Generally speaking, the simple side and the complex side of Photoshop
Elements serve different purposes. The straightforward Jekyll tools concen-
trate mostly on painting, and the more complex Hyde capabilities are devoted
to image editing. Therefore, to tackle this great program, you may find it help-
ful to understand the difference between the two terms.
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Painting without the mess
Painting is just what it sounds like: You take a brush loaded with color and
smear it all over your on-screen image. You can paint from scratch on a blank
canvas, or you can paint directly on top of a photograph. Notice in Figure 1-2
the charming young lady, possibly in costume to portray Glinda the Good
Witch in her high school’s production of the musical Wicked. We introduce
this lovely person solely to demonstrate the amazing functions of Elements.

Were you to paint on our unsuspecting fairy queen, you might arrive at some-
thing on the order of the image shown on the left in Figure 1-3. All these changes
were invoked using a single tool — the brush — and just two colors — black
and white. Clearly, the artistic work here is a little, shall we say, unsophisticated.
However, it’s worth pointing out that the image isn’t permanently damaged, as it
would have been with a real-life paintbrush. Because the original image is saved
to disk (as explained in Chapter 7), we can restore details from the original
whenever we get the whim.

Figure 1-2:
Are you a

good witch
or a bad

witch?
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Editing existing image detail
The lady on the left in Figure 1-3 may be entertaining to look at, but she’s
nothing compared to what she could be with the aid of some image editing.
When you edit an image, you distort and enhance its existing details. So
rather than paint with color, you paint with the image itself.

The lady on the right in Figure 1-3 demonstrates what we mean. To arrive at
this bizarre image, we started by doing a little plastic surgery on our subject,
using the Liquify filter as a substitute for the traditional ugly stick. Liquify was
also used to create her stylish hairdo. We selected her crown with the lasso
tool and placed it back on her head at a mischievous tilt. Her skirt was turned
into a sort of seahorse tail by the Twirl filter. We replaced her pitiful little fairy
wings with a pair of eagle wings from another picture, and then cut the whole
thing out and placed it on a new background. And finally, we used the custom
shape tool to draw the yin-yang symbol at the end of her wand, and applied a
couple of layer styles to give it dimensionality and a nice glow. We’re not sure
exactly what it all means, but she certainly has a little more credibility as an
authentic magical fairy-type creature than she did in the left image, huh?

Mind you, you don’t have to go quite so hog wild with image editing. If you’re a
photographer, for example, you may not care to mess with your work to the
point that it becomes completely unrecognizable. Figure 1-4 shows a subtle
adjustment that affects neither the form nor composition of the original image.
These kinds of changes merely accentuate details or downplay defects in the
image.

Figure 1-3:
The image
on the left

shows how
a few

strokes and
clicks of the

brush tool
can alter 

the image,
albeit in

rather crude
fashion. The

image on
the right

shows what
more

complex
tools can

accomplish.
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Just for the record, here are a few common ways to edit photographs in
Elements:

� You can sharpen an image to make it appear in better focus, as in Figure 1-4.
Generally, sharpening is used to account for focus problems in the scan-
ning process, but you can sometimes sharpen a photograph that was shot
out of focus.

� If you want to accentuate a foreground image, you can blur the focus of
the background.

� If a photograph is too light or too dark, you can fix it in a flash through
the miracle of color correction. You can change the contrast, brighten or
dim colors, and replace one color with another. The image in Figure 1-4
has been color-corrected.

� Using the selection and move tools, you can grab a chunk of your image
and physically move it around. You can also clone the selection, stretch
it, rotate it, or copy it to a different image.

And that’s only the tip of the iceberg. In the book’s remaining chapters you’ll
see Photoshop Elements examined as both a painting program and an image
editor. Some chapters contain a little bit of information on both topics, with
Part III pertaining to image editing in particular. But you’ll find all sides of
Photoshop Elements’ personality flourishing in this book.

Figure 1-4:
You can

apply more
moderate

edits to your
image, 

such as
sharpening

and color
correcting.
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Psychiatric Help: The Doctor Is Built In
Poor Dr. Jekyll. He spent all his time trying in vain to mix a drinkable antidote
for that split personality problem of his, when all he needed was to seek 
help from another doctor — one of the psychiatric kind. Luckily, Photoshop
Elements has seen the light, and the many built-in Help features that it puts at
your disposal ensure that you’ll never suffer by association with its split per-
sonality. Elements has woven the various aspects of its Help system together
in such a way that help is always just a click away.

The Welcome screen
Let’s start with first things first: The Welcome screen is the very first thing
you’ll see after you’ve fired up Photoshop Elements. (Don’t worry if you don’t
know how to start Photoshop Elements yet — we’ll cover that in the next
chapter. If you feel lost, just smile and nod as you read and come back to this
section later. We’ll understand.)

The Mac Welcome screen
As Figure 1-5 makes clear, the Mac Welcome screen gives you these options:

� Start from Scratch: Click here to start out with a pristine new canvas,
just waiting for you to express yourself all over it. You’ll be asked to
specify some properties of the new canvas; we’ll get to those in the next
few chapters.

� Open File for Editing: Click here to open the File Browser palette, which
lets you search for images on your hard drive, giving you image thumb-
nails to help you find exactly the file you’re looking for. We cover the File
Browser palette thoroughly in Chapter 3.

� Connect to Camera or Scanner: Click here to start the process of bring-
ing an image into Elements from a scanner, a digital camera, or an
already captured video. You’ll be taken to the Select Import Source
window, where you can choose a source from the Import menu. Frankly,
so many different scanners and cameras, each with its own quirks and
oddities, are available that we can’t possibly begin to thoroughly explain
this process for each and every device. But if you have a scanner or a
digital camera (and there’s a chance that your copy of Photoshop
Elements came bundled with just such a device), it’s of primary impor-
tance that you’ve correctly installed the software that came with your
digital device. For instance, if you’ve installed your scanner software
properly, you should see that option listed in the Import menu. If your
digital camera shows up as its own little hard drive when you connect it
to your computer, you may have better luck using the File➪Open com-
mand to import images from that camera instead of the Welcome screen.
(See Chapter 3 for the skinny on opening files.)
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You can also choose Frame from Video from the Import menu to be
taken to the VCR-style controls, which let you import a frame from pre-
captured video. Just click the Browse button to locate the video on your
hard drive, use the controls to locate your frame, and click the Grab
Frame button.

The Web site for the company that made your device can be a great
place to turn for help as well as an easy source for downloading updated
software for your device. And the Photoshop Elements manual that
came with the program has a surprising amount of helpful information.

� Recent Images: If you’ve opened or created any images recently with
Elements 3.0, you’ll see them listed here. Just click a name to open 
the file.

� Tutorials: Click here and Photoshop Elements will fire up your Web
browser to show you Elements tutorials on the Adobe Web site.

� Close: If every Elements option were this easy to understand, we’d never
sell any books. But don’t forget, you can always bring back the Welcome
screen by choosing Window➪Welcome.

Okay, there’s one more button in this window, though technically it’s a check
box. If you click the check box for Show at Startup to deactivate the Welcome
screen feature, you’ll receive a thoughtful reminder that this screen can be
turned on again by choosing Welcome under the Window menu.

Figure 1-5:
The Mac

Welcome
screen 

helps 
get your

Elements
work

session off
to a quick

start.
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The Windows Welcome screen
Figure 1-6 shows the Windows Welcome screen, which gives you seven icons
to click:

� Product Overview: Click here to find out a little general information
about Photoshop Elements. You’ll also find a link to special information
for users of Elements 2.0.

� View and Organize Photos: Clicking this link takes you straight to the
Organizer component of Elements, which we cover in Chapter 6.

� Quickly Fix Photos: This link takes you to the Quick Fix mode of the
Editor component in Elements, giving you access to some simple image-
editing controls.

� Edit and Enhance Photos: This link takes you to the Standard Edit mode
of the Editor component.

� Make Photo Creation: Click here to open the Creation Setup window,
part of the Organizer component. We cover Organizer’s creations in
Chapter 18.

� Start from Scratch: This link opens the Editor component and takes you
straight to the New dialog box, where you can specify some properties
for the new canvas you want to create. We explain those properties in
the next few chapters.

� Tutorials: Click here and Photoshop Elements will fire up your Web
browser to show you Elements tutorials on the Adobe Web site.

The Start Up In menu at the bottom-left corner of the screen lets you specify
how you want your Elements sessions to begin. Welcome Screen is selected
by default, which means when you start Elements, the first thing you see is
this screen. You can also choose Editor or Organizer if you want to skip the
Welcome screen and have Elements open in one of its two components. But
you can always choose Welcome from the Window menu of either Editor or
Organizer to access the Welcome menu again.

Adobe Help
Whether you’re in Elements on the Mac or in either component of Elements
in Windows, the first command available under the Help menu is Photoshop
Elements Help. Here you have access to the built-in help information that
Adobe provides. This help is divided into three sections: Contents, Index, and
Glossary. You can access these sections by clicking the tabs at the top of the
left panel in the Adobe Help window. Provided you have an Internet connec-
tion, clicking the Go to Adobe Help Online link in the lower-left corner of the
window loads the Support page from Adobe’s Web site. You can also open
this page in your Web browser by choosing Help➪Online Support. Adobe has
many helpful features here, including the Forums link, which can take you to
the online community of Photoshop Elements users.
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The scores of warnings, messages, and dialog boxes that appear throughout
the program often feature technical words that you may find confusing.
These words are usually underlined and colored blue, like links on Web
pages. Sure enough, clicking one of these words gives you a link straight to
Adobe Help, where you’ll find a definition of the word or term.

Yet another way to access Adobe Help is through the interface’s Search field.
On the Mac, this feature is located in the shortcuts bar; in Windows, it’s in
the main menu bar. By default, the field reads “Type a question for help”; if
you follow its sage advice and then press Enter (Return on the Mac), you’ll be
taken to Adobe Help for the answer. You can also click the adjacent question
mark icon to activate Adobe Help.

The How To palette
The How To palette, pictured in Figure 1-7, is the place to turn in Elements for
the latest and greatest recipes. Now, if the thought of recipes makes you
hungry, put down this book, make yourself a sandwich, eat it, and then come
back to us when you’re finished (but please wipe your hands first). These
recipes can’t help you remember how to make your great-aunt Naomi’s meat-
loaf, but they are a big help where Photoshop Elements is concerned.

Figure 1-6:
The

Windows
Welcome

screen
presents

several
options

which take
you to either
the Editor or

Organizer
component

of Elements.
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In the How To palette, you’ll find an assortment of image-editing recipes 
for doing common tasks such as removing dust and scratches from scanned
photos and restoring faded photos. You can click to be guided through the
tutorial step-by-step. Browser-style forward and backward icons are at the top
of the How To palette, as well as a printer icon you can click to print the cur-
rent tutorial.

You know, there’s another way you can apply the whole Jekyll/Hyde analogy
to Photoshop Elements. Although Elements definitely has its wild and woolly
Hyde side, full of intimidating tools and forbidding commands, the Dr. Jekyll
side of Elements — represented by all the Help features — is dedicated to
making sure you understand the darker side of the program. Doctors are gen-
erally helpful that way. So with this much help at your fingertips, why have
we decided to write this book? Well, we thought you might want a second
opinion.

Figure 1-7:
The How To

palette
presents
you with

step-by-step
tutorials for

image
editing.
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